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1 Introduction

1.1 Service Hawk

Thank you for using Service Hawk!

Service Hawk monitors your Windows Services and keeps them up and running, so server
downtime is kept to a minimum.  Service Hawk can also periodically restart services on a
user-defined schedule regardless of their state, ensuring that the service is running
smoothly and stays operational.

Security breaches take place every day, but that doesn't mean you should have to
spend lots of time or money monitoring your servers just to make sure you are
protected. Hackers, bugs, or even system crashes can wreak havoc on the profitability of
your business if given the opportunity. You must protect yourself from disasters like
this! The good news? Service Hawk can do it for you. Automatically.

·  Rest easy knowing your servers are up and running!
·  Schedule services to automatically restart regardless of their current state.
·  Keep expensive downtime to a minimum.
·  Services are automatically restarted - no human intervention required!
·  Get immediate notifications via Email, on-screen messages, or sound alerts.
·  No limit to the number of services you can monitor.
·  Runs on Windows NT, 2000, XP, and Server 2003.
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·  Free top-notch Technical Support included with purchase.
·  One full year of free software upgrades included with purchase.
·  30-day Unconditional 100% Money Back Triple Guarantee.
·  Instant Product Key delivery via email.
·  Ensure your security today! - Only US $279.00, with FREE shipping on all CD-ROM

orders!
·  We also have Volume Pricing.

Case Study

Imagine this scenario: You own a small ISP that runs web servers for hundreds of clients.
Unexpectedly, a hacker breaks into your network and shuts down all of your web servers.
You may not be aware of this tragedy for hours, but your clients sure are! This loss of
web presence is cutting into their bottom line and they are losing money. Not
surprisingly, several of your clients decide to take their business elsewhere because, in
their eyes, you are now an unreliable company. Don't let this happen to you!

Sound far-fetched? Unfortunately, scenarios like this occur all the time and are becoming
more frequent. Fortunately, Service Hawk can monitor and restart your Windows
Services for you, automatically, so you will be ready when hackers or bugs in the system
threaten to bring down your services.

Features

·  Selectively choose which services you wish to monitor, and specify how often to verify
their status.

·  Optional service failure notifications via customizable emails, on-screen messages, and
sound alerts.

·  Send email notifications to multiple recipients.
·  Easily keep track of past service interruptions via comprehensive logging.
·  Control individual services (Start/Stop, Pause/Resume, Restart) directly from within

Service Hawk.
·  Modify start-up type for each service (Automatic, Manual, Disabled).
·  Optionally include low-level Kernel and System Driver services.
·  Supports both HTML and plain text email notifications.
·  Add one or more file attachments to email notifications.

1.2 Ordering Information

Our order form utilizes a secure server (using SSL) to process your transaction, so your
ordering information will be encrypted and kept safe. We also offer a 30-day

http://www.servicehawk.com/support.html?loc=docs
http://www.servicehawk.com/guarantee.html?loc=docs
http://www.servicehawk.com/prices.html?loc=docs
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unconditional 100% money back Triple Guarantee on all of our products!

Order Service Hawk Online:

Click the Buy Now! button to visit our secure online order form, and order your copy of
Service Hawk today!  Service Hawk may be ordered through our secure online store 24
hours a day, seven days a week.

(Note: Pricing information is available here.)

Full Version Benefits:

1. Instant Product Key delivery via email.
2. FREE shipping on all CD-ROM orders.
3. One full year of free software upgrades included with purchase.
4. FREE top-notch Technical Support.
5. 30-day Unconditional 100% Money Back Triple Guarantee.

Additional Payment Methods:

If you prefer, we also provide the ability for you to place your order via Fax, Phone,
Postal Mail or Purchase Order. (Send an email to sales@wingenuity.com for more details.
Please indicate the payment method you would like to use.)

1.3 Customer Support

Our stance on customer support is simple: You, our customer, are the most
important asset to our business! We go all-out to ensure that our technical support is
among the absolute best in the business. Many believe that the greatest cost in running
a successful business is acquiring new customers. That's why you will be treated like 
gold by our technical support staff once we have you on board as one of our customers.
We want you to be our customer for life, so we will always take care of you in a prompt,
friendly and helpful manner.  If you have an issue that needs to be resolved, visit our
Customer Support Center today for a quick resolution!

http://www.servicehawk.com/guarantee.html?loc=docs
http://www.wingenuity.com/buy-now.html?action=buy_now&products_id=1&app=ServiceHawk&loc=docs
http://www.servicehawk.com/prices.html?loc=docs
http://www.servicehawk.com/guarantee.html?loc=docs
mailto:sales@wingenuity.com
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Customer Support Center:

http://www.servicehawk.com/support.html

Bug Reports:

(Note: Before submitting a bug report, visit the Downloads page to ensure that you are
using the latest released version of Service Hawk.)

We strive to ensure that no bugs are released in any of our software products. However,
this is nearly impossible for even the best software producers to achieve. If you should
happen to encounter a bug in any of our software products, we believe it is our
responsibility to fix it. As software consumers ourselves, it absolutely frustrates us to
spend our time and money on software and then find we cannot get it to run properly.
Providing our users with a way to report bugs shows that we are committed to releasing
high quality software products, and allows us to focus on creating the most stable
applications possible.

Please report any issues you are having with our software via email.  Be sure to include
the following information:

1. When and how did the problem occur?
2. Can you reproduce the problem?  If yes, please list down the steps.
3. Which version of Service Hawk are you running?  You can get this information from
the About Service Hawk dialog.
4. Which version of Microsoft Windows are you using (98, XP, 2000, 2003, Vista, etc.)?
5. If there were any error messages shown, please include the full text of the error
messages.
6. Any other information which you think may help us identify the cause of this
problem.

Feature Requests:

We cannot guarantee that any requested features will be implemented in future versions
of our software. However, we do evaluate each and every suggestion and do our best to
incorporate those that will be useful to the majority of our user base. If you have a
suggestion for a new feature, please let us know!

http://www.servicehawk.com/support.html?loc=docs
http://www.servicehawk.com/download.html?loc=docs
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1.4 Contacting Wingenuity, Inc.

Mailing Address:

Wingenuity, Inc.

69947 S River Rd

White Pigeon, MI  49099-9015

USA

Corporate Homepage:

http://www.wingenuity.com/

Service Hawk Homepage:

http://www.servicehawk.com/

Customer Support Center:

http://www.servicehawk.com/support.html

General Information:

info@wingenuity.com

Sales Email:

sales@wingenuity.com

Sales Phone:

1-269-978-8840

1-866-391-0418 Toll Free

1.5 License Agreement (EULA)

CAREFULLY READ THE FOLLOWING LICENSE AGREEMENT.  BY OPENING THE PACKAGE
OR CLICKING ON THE "I ACCEPT THE AGREEMENT" BUTTON, YOU ARE CONSENTING TO
BE BOUND BY AND ARE BECOMING A PARTY TO THIS AGREEMENT.  IF YOU DO NOT

http://www.wingenuity.com/index.html?app=ServiceHawk&loc=docs
http://www.servicehawk.com/?loc=docs
http://www.servicehawk.com/support.html?loc=docs
mailto:info@wingenuity.com
mailto:sales@wingenuity.com
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AGREE TO ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT, CLICK THE "I DO
NOT ACCEPT THE AGREEMENT" BUTTON, AND, IF APPLICABLE, IMMEDIATELY RETURN
THIS PRODUCT AND ALL ASSOCIATED PACKAGING AND DOCUMENTATION TO
WINGENUITY, INC. FOR A FULL REFUND.

This End User License Agreement ("Agreement") is a legally binding contract between the
person or entity ("End User") using the Service Hawk software ("Software") and
Wingenuity, Inc. ("Licensor").  This Agreement governs your use of the Software and
related explanatory written materials ("Documentation").  "Software" includes any
upgrades, modified versions, updates, additions and copies of the Software.  "You" and
"your" means the person or entity that is being licensed to use the Software or
Documentation. "We" and "us" means Wingenuity, Inc.

Be sure that you carefully read and fully understand this Agreement.  Wingenuity, Inc. is
only willing to provide you with a license to the Software and Documentation on the
condition that you accept all of the terms and conditions contained in this Agreement.

Your use of the Software or Documentation will constitute your acceptance of, and
agreement to be bound by, all the terms and conditions of this Agreement.  The Software
is "in use" on a computer when it is loaded into temporary memory (RAM) or installed
into the permanent memory of a computer--for example, a hard disk, CD-ROM,
DVD-ROM or other media or storage device.

License Grant

The Software and Documentation are provided to you for use only under the following
terms.  We reserve all rights not expressly granted to you in this Agreement.  You own
the media on which the Software is recorded, but we retain ownership of all copies of the
Software itself.  You assume sole responsibility for the installation, use and results
obtained from use of the Software.

We hereby grant you a limited, nonexclusive, nontransferable license to do only the
following:

• Use the free trial version of the Software for a period of thirty (30) days.  After the trial
period has concluded, you must pay the license fee in order to continue using the
Software.  If you choose not to license the Software by paying the license fee, the
Software must be completely and entirely deleted from all computers in which the
Software has been copied to or installed.

• Install and use the Software on one computer per license at any time for use only in
your own home or place of business.  At no time shall the Software be installed on two or
more computers at the same time unless a separate license is purchased for each
computer on which the Software is to be installed.
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• You may either make one copy of the Software solely for backup or archival purposes,
or transfer the Software to a single hard disk, provided you keep the original solely for
backup or archival purposes.  The original and copy of the Software must be kept in your
possession or control, and your installation and use of the Software must not exceed that
which is allowed by this Agreement.  If you receive the first copy of the Software
electronically and a second copy on physical media (e.g., CD-ROM, DVD-ROM, etc.), the
second copy may be used for archival purposes only and may not be transferred to or
used by any other person or entity.

Things You May Not Do

The Software and Documentation are protected by United States copyright laws and
international treaties. You must treat the Software and Documentation like any other
copyrighted material--for example a book.

You may not:

• copy the Documentation,

• copy the Software except to make archival or backup copies as provided above,

• modify, adapt or translate the Software or merge it into another program,

• create derivative works based upon the Software or any part thereof,

• reverse engineer, disassemble or decompile the Software, make any attempt to
discover the source code of the Software, or otherwise reduce the Software to a human
readable form,

• make the Software accessible via a public network such as the Internet or other
file-sharing services, or

• sublicense, assign, rent, resell, lease or lend any portion of the Software or
Documentation.

Title

We remain the owner of all right, title and interest in the Software and Documentation. 
Through your use of the Software, you acquire no ownership interest in the Software or
any component of the Software.  No right, title or interest in or to any trademark, service
mark, logo or trade name of ours is granted to you under this Agreement.  We are the
owner of the copyright for the Software and we reserve all rights related to such
ownership, including the right to duplicate and sell the Software.

Limited Warranty
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We warrant that for a period of thirty (30) days after delivery of this copy of the Software
to you:

• the Software will perform in substantial accordance with the Documentation, and

• the physical media on which this copy of the Software is provided to you will be free
from defects in materials and workmanship under normal use.  If the media fails to
conform to this warranty you may, as your sole and exclusive remedy, obtain a
replacement free of charge if you notify us in writing within thirty (30) days after you
purchase the Software.

To the extent permitted by applicable law, THE FOREGOING LIMITED WARRANTY IS IN
LIEU OF ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, AND WE
DISCLAIM ANY AND ALL IMPLIED WARRANTIES OR CONDITIONS, INCLUDING ANY
IMPLIED WARRANTY OF TITLE, NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE, regardless of whether we know or had reason to know of your
particular needs.  No employee, agent, affiliate, dealer or distributor of ours is authorized
to extend or modify this limited warranty, nor to make any additional warranties.

The above warranty does not cover any Software that has been altered or changed in any
way by anyone other than us.  We are not responsible for problems associated with or
caused by incompatible operating systems or equipment, or for problems in the
interaction of the Software with software not furnished by us.  We do not warrant or
promise that the Software is free from bugs or errors, nor do we make any other
promises about the performance, suitability, accuracy, or reliability of the Software, or its
ability to meet your requirements.

SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO
STATE.

Limited Remedy

Our entire liability and your exclusive remedy shall be:

• the replacement of any CD-ROM(s) or other media not meeting our Limited Warranty
which is returned to us or to an authorized Dealer or Distributor with a copy of your
receipt, or

• if we or an authorized Dealer or Distributor are unable to deliver a replacement
CD-ROM(s) or other media that is free of defects in materials or workmanship, you may
terminate this Agreement by returning the Software and Documentation and your money
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will be refunded.

IN NO EVENT WILL LICENSOR OR THEIR RESPECTIVE DIRECTORS, OFFICERS,
EMPLOYEES, AFFILIATES OR SUBSIDIARIES BE LIABLE TO YOU THE END USER,
REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT,
INCLUDING NEGLIGENCE, FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, LOST DATA, LOST
PROFITS OR BUSINESS, LOST SAVINGS, BUSINESS INTERRUPTION, LOSS OF USE,
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING FROM THE USE OF OR THE
INABILITY TO USE THE SOFTWARE, OR FOR ANY CLAIM OR DEMAND AGAINST YOU BY
ANY OTHER PARTY, EVEN IF LICENSOR, OR THEIR AFFILIATES OR SUBSIDIARIES HAVE
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT
APPLY TO YOU.

You agree that we, and our respective subsidiaries and affiliates will not at any time have
any additional liability for any claim, cause of action or injury that you or any other
person may have as a result of: (1) your incorrect usage of the Software or any
documents generated by the Software; (2) connection or toll charges for using the
Software or obtaining updates for the Software; or (3) any fees, costs or expenses
arising out of troubleshooting or technical support for the Software.

You agree that the essential purposes of this Agreement can be fulfilled even with these
limitations on liabilities.  You acknowledge that we would not be able to offer the
Software on an economical basis without these limitations.

Protection and Security

You agree to use your best efforts and to take all reasonable steps to safeguard the
Software to ensure that no unauthorized person or entity shall have access thereto and
that no unauthorized copy, publication, disclosure or distribution in whole or in part, in
any form, shall be made.  You acknowledge that the Software contains valuable
confidential information and trade secrets and that unauthorized use and/or copying is
harmful to us.

Term and Termination

This license agreement takes effect upon your use of the software and remains effective
until terminated.  This Agreement will automatically terminate without notice from us if
you fail to comply with any of its provisions.  You may terminate it at any time by



Introduction 11

Copyright © 1999-2009 Wingenuity, Inc.  All Rights Reserved.

destroying all copies of the Software and Documentation in your possession.  You agree
on termination of this license to either return to us or destroy all copies of the Software
and Documentation in your possession.

Confidentiality

The Software contains trade secrets and proprietary knowledge that belong to us and it is
being made available to you in strict confidence.  ANY USE OR DISCLOSURE OF THE
SOFTWARE, OR OF ITS ALGORITHMS, PROTOCOLS OR INTERFACES, OTHER THAN IN
STRICT ACCORDANCE WITH THIS LICENSE AGREEMENT, MAY BE ACTIONABLE AS A
VIOLATION OF OUR TRADE SECRET RIGHTS.

Severability

If any provision of this Agreement is determined to be illegal or unenforceable, such
provision shall be automatically reformed and construed so as to be valid, operative and
enforceable to the maximum extent permitted by law or equity while preserving its
original intent.  The invalidity of any part of this Agreement shall not render the
remainder of this Agreement invalid.

Entire Agreement

This Agreement constitutes the entire and exclusive agreement between you and us
concerning the Software and Documentation, and all prior communications, proposals,
agreements, representations, statements and undertakings, either oral or written, are
hereby expressly canceled and superseded.  No representations or statements of any
kind made by any of our representatives, affiliates or subsidiaries, which are not included
in this agreement, shall be binding on us.

Governing Law; Forum

This Agreement shall be governed by the laws of the State of Michigan, without regard to
conflicts of law provisions.  The exclusive jurisdiction of any dispute arising out of, or
relating to, this Agreement or any dispute arising out of, or relating to, the Software or
Documentation or services provided in connection therewith shall be in the courts located
in the county of Cass, State of Michigan.  If any provision of this Agreement is held by a
court of competent jurisdiction to be invalid or unenforceable to any extent under
applicable law, that provision will be enforced to the maximum extent permissible and
the remaining provisions of this Agreement will remain in full force and effect.

Waiver
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No waiver of any provision or condition herein shall be valid unless in writing and signed
by you and one of our authorized representatives.  Our failure to insist upon or enforce
strict performance of any provision of this Agreement or any right shall not be construed
as a waiver of any such provision or right.

Export Provisions

You agree that the Software will not be shipped, transferred or exported into any country
or used in any manner prohibited by the United States Export Administration Act or any
other export laws, restrictions or regulations.

Acknowledgment

BY USING THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS
AGREEMENT, UNDERSTAND IT, AND AGREE TO BE BOUND BY ALL TERMS AND
CONDITIONS CONTAINED HEREIN.

1.6 Distribution Permission

Wingenuity, Inc. allows and encourages all web sites, on-line services, CD-ROM vendors,
and end-users to freely distribute the trial version of Service Hawk. If you wish to
distribute this software, you may obtain the most recent trial version from 
http://www.servicehawk.com. Licensed versions may not be distributed.

1.7 Check for Updates

From the Help menu...

http://www.servicehawk.com/?loc=docs
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...click "Check for Updates..." to launch your default browser which checks to see if you
have the latest version of Service Hawk installed.
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2 Installation

2.1 System Requirements

Service Hawk requires a Windows platform that utilizes Windows Services (also known as
NT Services).

Such compatible platforms include:

· Windows Server 2008
· Windows Server 2003
· Windows Vista
· Windows XP
· Windows 2000 
· Windows NT 4.0

The following versions of Windows do not have the concept of Windows Services, and
thus are not compatible with Service Hawk:

· Window 3.x or any older version of Windows
· Windows 95
· Windows 98
· Windows 98 Second Edition (SE)
· Windows Millennium Edition (ME)

2.2 Installing Service Hawk

Installing from CD-ROM:

1. Insert the CD-ROM into your CD-ROM drive.
2. Run the ServiceHawkSetup.exe program:

3. If you have auto run enabled, the ServiceHawkSetup.exe program will start
automatically when you insert the CD-ROM.

4. If you do not have auto run enabled (or the ServiceHawkSetup.exe program does
not start automatically):

5. Double-click My Computer from your Desktop.
6. Click on the CD-ROM drive icon.
7. Double-click the ServiceHawkSetup.exe program icon.

8. Follow the on-screen instructions as the setup program guides you through the
installation process.

Installing from download:

1. Download ServiceHawkSetup.exe to your Desktop (or any other folder of your
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choice).
2. Double-click the ServiceHawkSetup.exe program icon on your Desktop.
3. Follow the on-screen instructions as the setup program guides you through the
installation process.

2.3 Enter Product Key

Once you have purchased Service Hawk, your personal Product Key will be sent to you
via email.  Follow the steps below for the easiest way to unlock your copy of Service
Hawk:

1. Highlight the Registration Information section of this email (including the dashed
lines) and copy it to your clipboard by pressing Ctrl+C on your keyboard.

2. Run Service Hawk and choose "Enter Product Key..." from the Help menu.

The registration information should automatically be filled in for you (though you may
have to click the Grab Clipboard button).  Click OK to finish the process.  If this process
fails, you may need to manually type the registration information into the Enter Product
Key dialog.  Please make sure to enter the information EXACTLY as indicated to you in
the registration email.  You might want to manually copy and paste the Registration
Information into the Enter Product Key dialog.  Your Product Key is unique to you, and is
associated with the order you placed when you purchased Service Hawk.

If successful, you will see the "Product key accepted.  Thank you for purchasing Service
Hawk!" message. If you see the "You have provided an invalid name or product key."
message instead, carefully check over the registration information ensuring that it was
entered by following the previous steps. If you still have problems unlocking your copy of
Service Hawk, please contact us via email for help. (Include both the original Order
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Number and your unique Product Key located in the registration email.)

2.4 Upgrading from a previous version

It is recommended that you uninstall any previous versions of Service Hawk prior to
installing the latest version.  Before upgrading, however, please ensure that you have a
valid product key for the newer version, or your unlocked copy of the older version will
turn into a trial copy of the newer version.

2.5 Uninstalling Service Hawk

Service Hawk may be uninstalled in one of two ways:

· Click the Uninstall Service Hawk icon in the Start Menu.  (Start | Programs | Service
Hawk | Uninstall Service Hawk)

· Open the Windows Control Panel and double click on Add/Remove Programs.  Then
choose Service Hawk from the list of applications to uninstall.
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3 Using Service Hawk

3.1 Main Window

Service Hawk's main window is comprised of two lists.  The first list, also known as the 
Services List, displays all Windows Services currently installed on the machine.  This list
represents the services that you can choose to monitor with Service Hawk.

The second list, also known as the Watch List, holds the services that Service Hawk is
currently monitoring.  To add a service to the Watch List, simply double-click a service in
the Services List.  You may also right-click the service and choose "Add to Watch List"
from the pop-up menu.  Lastly, you may also choose to drag and drop a service from one
list to the other (see Drag and Drop  for more information).

It is important to note the difference between a service being in the Watch List, and
scheduling the service to restart periodically via the Scheduled Restart  window.
Adding a service to the Watch List ensures that the service will get restarted immediately
after Service Hawk notices that it is not currently running.  Scheduling a restart for the
service will take place at the specified restart time regardless of what state the specified
service is currently in (even if the service is currently running).  This is particularly useful
for ensuring that a service is running in a healthy state.  Sometimes a service will report
that it is "running" but is in a hung or frozen state, so scheduling an automatic restart
can work around this problem in most cases.

22

21
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3.2 Service Properties Window

To display the Service Properties window, right-click on a service from Service Hawk's
main window and choose "Properties..." from the popup menu.  This window allows you
to modify the Startup Type for the selected service, and displays all other pertinent
information for the service in a single easy-to-read location.
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3.3 Scheduled Restart Window

To display the Scheduled Restart window, right-click on a service from Service Hawk's
main window and choose "Add/Edit Scheduled Restart..." from the popup menu.  This
window allows you to add or edit the restart schedule for the selected service.  You may
add a scheduled restart for a service regardless if the service is in the main Service List

 or the Watch List .

It is important to note the difference between a service being in the Watch List , and
scheduling the service to restart periodically via this window.  Adding a service to the
Watch List ensures that the service will get restarted immediately after Service Hawk
notices that it is not currently running.  Scheduling a restart for the service will take
place at the specified restart time regardless of what state the specified service is
currently in (even if the service is currently running).  This is particularly useful for
ensuring that a service is running in a healthy state.  Sometimes after a service has been
running for a certain amount of time it will still report that it is "running" but is in a hung
or frozen state, so scheduling an automatic restart can work around this problem in most
cases.

Restart Frequency - Specifies how frequently the selected service will be restarted.

Restart Time / Base Time - Specifies the time in which the selected service will be
restarted.  NOTE: When a Restart Frequency of Custom is used, this value is used as a
Base Time for which the custom time will be used as an offset to determine when the
service will be restarted.  For example, if the Base Time is 12:00 AM (midnight) and the
service is configured to restart every 30 seconds then the service will restart at
12:00:30, 12:01:00, 12:01:30, etc.

Schedule Restart - Daily - Specifies the number of days between restarts for the
selected service.

Schedule Restart - Weekly - Specifies the days of the week in which the selected

19 19

19
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service will be restarted.

Schedule Restart - Custom - Specifies the number of days, hours, minutes and
seconds until the selected service is restarted.

3.4 Drag and Drop

Service Hawk supports drag and drop in the following ways:

· Drag and drop a service from the Services list to the Watch List, and vice versa.

· Drag and drop the column headers for the Services List to rearrange the column order.

· Drag and drop the column headers for the Watch List to rearrange the column order.

NOTE: The order (and size) of each column is saved when Service Hawk exits and are
restored automatically upon subsequent instances of the application.

3.5 Menus

3.5.1 Main Menu

The File menu has the following sub-menus:

1. Exit - Exits the Service Hawk application.

The Tools menu has the following sub-menus:

1. Options... - Configures various global application settings.
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The Help menu has the following sub-menus:

1. Service Hawk Help... - Launches this help file.
2. Check for Updates... - Checks to see if there is an updated version of Service Hawk

available.
3. Ordering Information... - Launches the Service Hawk ordering information web

page.
4. Service Hawk Homepage... - Launches the Service Hawk homepage.
5. Enter Product Key... - Allows you to enter (or update) the product key.
6. About Service Hawk... - Launches the About Service Hawk dialog.

The Buy Now!... menu has the following sub-menus:

(Note: This menu disappears when a valid product key has been entered and accepted.)

1. Order Online - Launches the Service Hawk ordering information web page.
4. Enter Product Key... - Allows you to enter the product key.  To change the product

key at a later date, click Enter Product Key... from the Help menu.
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3.5.2 Context Menus

The Service List Context menu has the following sub-menus:

1. Add to Watch List - Adds the selected service to the Watch List, removing it from
the Service List.

2. Add/Edit Scheduled Restart... - Launches the Scheduled Restart  window.
3. Delete Scheduled Restart - Deletes the scheduled restart for the selected service. 

(Note: This menu item is disabled when the selected service is not currently
scheduled to automatically restart.)

4. Start Service - Starts the selected service. - (Note: This menu item is disabled when
the selected service is already started.)

5. Stop Service - Stops the selected service. - (Note: This menu item is disabled when
the selected service is already stopped.)

6. Pause Service - Pauses the selected service. - (Note: Not all services can be
paused.  This menu item is disabled when the selected service is unable to be
paused.)

7. Resume Service - Resumes the selected service. - (Note: This menu item is
disabled when the selected service is not in the paused state.)

8. Restart Service - Restarts the selected service. - (Note: This menu item is disabled
when the selected service is already stopped.)

9. Refresh - Refreshes the list of services, and their states, in the Service List.
10. Properties... - Launches the Service Properties window .

The Watch List Context menu has the following sub-menus:
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1. Remove from Watch List - Removes the selected service from the Watch List,
adding it back to the Service List.

2. Add/Edit Scheduled Restart... - Launches the Scheduled Restart  window.
3. Delete Scheduled Restart - Deletes the scheduled restart for the selected service. 

(Note: This menu item is disabled when the selected service is not currently
scheduled to automatically restart.)

4. Refresh - Refreshes the list of services, and their states, in the Watch List.
5. Properties... - Launches the Service Properties window .

3.6 Application Options

3.6.1 General

21
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Services:

1. Show Kernel and System Driver services - Check this option is you would like
Service Hawk to add Kernel and System Driver services to the Watch List .  Once
they have been added to the Watch List, these services are treated like normal
services and can be monitored in a similar fashion.  This option is disabled by
default.

2. Check service status every NN seconds - This setting specifies how often Service
Hawk will check the status of the services currently in the Watch List .  Configuring
Service Hawk to check the service status less than every 30 seconds is not
recommended.  While not restricted, it may cause unnecessary strain and lead to
performance problems.  WARNING: If this option is disabled, Service Hawk does not
check the status of any services in the Watch List, and thus will not restart any
services.  This option is enabled by default.  The default time is 60 seconds.

3. Resume paused services on status check - Check this option if you would like
Service Hawk to restart services in the watch list that have a "paused" status.  This
option is enabled by default.c

Log File Maintenance:

1. Auto purge log file at NN bytes - When this option is checked, Service Hawk's log
file (ServiceHawk.log) will be purged automatically when it reaches the number of
bytes indicated.  If this option is disabled Service Hawk will not purge the log file. 
This option is enabled by default.  The default file size is 1 MB, or 1048576 bytes.

2. Create a backup of log file before purging - Check this option if you would like
the log file to be backed up before purging its contents.  The backups will be stored
in the same directory as the original log file, and are named with the following
naming convention: ServiceHawk.log.0001, ServiceHawk.log.0002, etc.  This option
is only enabled when the "Auto purge log file at N bytes" option is enabled.  This
option is enabled by default.

Check for Updates:

1. Automatically check for updates on startup - Check this option is you would like
to automatically check for updates each time Service Hawk is started.  This option is
disabled by default.

2. Remind me occasionally to check for updates - Check this option if you would
like Service Hawk to remind you when it has been a while since the last time you
checked for updates.  This option is only enabled when the "Automatically check for
updates on startup" option is not checked.  This option is disabled by default.
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3.6.2 Email Configuration

Outgoing SMTP Servers:

1. Outgoing SMTP (Simple Mail Transfer Protocol) Server - Specifies the outgoing
SMTP server used to send email notifications.  Fully qualified domain names as well
as IP addresses are both valid.  (e.g. mail.mycompany.com or 123.123.123.123)

2. Outgoing SMTP (Simple Mail Transfer Protocol) Server Port - Specifies the port
number to use when establishing a connection with the outgoing SMTP server.  The
default port number is 25.

Server Authentication:

1. SMTP (Simple Mail Transfer Protocol) server requires authentication - Check
this option if the specified SMTP server requires user authentication.  Checking this
option will enable the Method, Username and Password fields.  This option is disabled
by default.

2. SMTP Authentication Method - Specifies the authentication method used by the
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SMTP server.  This option is only enabled when the "SMTP server requires
authentication" option is enabled.  Possible choices include: AUTH LOGIN, AUTH
PLAIN, CRAM MD5, or NTLM.  Consult your SMTP server's documentation for more
information regarding these types of authentication methods.  Most common choices
are AUTH LOGIN and AUTH PLAIN.  If in doubt try using AUTH LOGIN first.

3. SMTP Username - Specifies the username that is required for authentication by
your SMTP server.

4. SMTP Password - Specifies the password that is required for authentication by your
SMTP server.  NOTE: Your password is encrypted before it is stored and is never
stored in plain text for security purposes.

Miscellaneous:

1. MIME (Multiple Internet Mail Extensions) encode all messages - Check this
option if you wish to use MIME encoding for all email notifications.  This option is
disabled by default.  If you are sending email messages as HTML, or plan to specify
one or more attachments , this option should be enabled.

2. Send messages as HTML (Hyper Text Markup Language) - Check this option if
you wish to send all email notifications as HTML mail, thus allowing the use of HTML
tags in the Email Message  field.  This option is enabled by default.

32
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3.6.3 Email Message

Sender (From...):

1. Name - Specifies the "From" name to be used when sending notification emails.
2. Email - Specifies the "From" Email to be used when sending notification emails.

Recipient (To...):

1. Name - Specifies the "To" name to be used when sending notification emails.
2. Email - Specifies the "To" Email to be used when sending notification emails.

Carbon Copies:

1. Cc... - Specifies the carbon copy list used when sending notification emails.  The
values in this list must be separated by either commas or semicolons.  (e.g.
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user1@domain.com;user2@domain.com;user3@domain.com )
2. Bcc... - Specifies the blind carbon copy list used when sending notification emails.

The values in this list must be separated by either commas or semicolons.  (e.g.
user1@domain.com;user2@domain.com;user3@domain.com )

Priority:

1. High - Specifies high priority for the notification emails.  This value is read by the
email client which displays the priority accordingly.  (X-Priority header values: High
= 1, Normal = 3, Low = 5)

2. Normal - Specifies normal priority for the notification emails.  This value is read by
the email client which displays the priority accordingly.  (X-Priority header values:
High = 1, Normal = 3, Low = 5)

3. Low - Specifies low priority for the notification emails.  This value is read by the
email client which displays the priority accordingly.  (X-Priority header values: High
= 1, Normal = 3, Low = 5)

Message:

1. Subject - Specifies the subject to be used when sending notification emails.
2. Body - Specifies the email body to be used when sending notification emails.  If you

wish to include HTML tags, make sure that the "Send messages as HTML" option is
enabled on the Email Config  tab.  See Dynamic Email Variables  for details on
how to add dynamic information to the email message.

3.6.3.1 Dynamic Email Variables

Service Hawk allows you to add dynamic information to the body, as well as the subject,
of outgoing email notifications.  Simply use the variables below, including the "%%"
beginning and ending tags in the Message Body  and/or the Message Subject .

Variable : Replaced With:

%%SERVICE_NAME%% Display name of the service in question.

%%SERVICE_NAME_SHORT%% Short name of the service in question.

%%SERVICE_STARTUP_TYPE%
%

Startup Type of the service in question.

%%SERVICE_DESCRIPTION%% Description of the service in question.

%%SERVICE_EXE_PATH%% Path to the executable associated with the service .

%%SYSTEM_DAY_NAME%% Current day (long).  Monday, Tuesday, etc.

%%SYSTEM_DAY_NAME_SHOR
T%%

Current day (short).  Mon, Tue, Wed, etc.
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%%SYSTEM_MONTH_NAME%% Current month (long).  January, February, etc.

%%SYSTEM_MONTH_NAME_SH
ORT%%

Current month (short).  Jan, Feb, Mar, etc.

%%SYSTEM_YEAR%% Current year in four digit format.  YYYY

%%SYSTEM_YEAR_SHORT%% Current year in two digit format.  YY

%%SYSTEM_DAY_OF_WEEK%
%

Current day of week in decimal format.  0-6, Sunday is
0

%%SYSTEM_DAY_OF_MONTH%
%

Current day of month in decimal format.  01-31

%%SYSTEM_DAY_OF_YEAR%% Current day of year in decimal format.  001-366

%%SYSTEM_WEEK_OF_YEAR_S
UNDAY%%

Current week of year in decimal format (Sunday as first
day).  00-53

%%SYSTEM_WEEK_OF_YEAR_M
ONDAY%%

Current week of year in decimal format (Monday as first
day).  00-53

%%SYSTEM_MONTH_OF_YEAR
%%

Current month of year in decimal format.  01-12

%%SYSTEM_HOUR_12%% Current hour in 12-hour format.  01-12

%%SYSTEM_HOUR_24%% Current hour in 24-hour format.  00-24

%%SYSTEM_MINUTES%% Current minute as decimal number.  00-59

%%SYSTEM_SECONDS%% Current second as decimal number.  00-59

%%SYSTEM_AM_PM%% Current A.M./P.M. indicator.  AM or PM

%%SYSTEM_TIME_ZONE%% System time zone name or abbreviation.

%%SYSTEM_DATE_TIME%% Current date/time in the following format:

Thursday, August 09, 2007 : 13:45:59

%%HOSTNAME%% Hostname of machine running the service in question.
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3.6.4 Notifications

Email Notifications:

1. Enable Email notifications - Check this option if you wish to have Service Hawk
generate and send email notifications upon finding a stopped service.  It is important
to note that this option MUST be enabled for Service Hawk to send email
notifications, even if all other email configuration settings have been entered.  This
option is disabled by default.

2. Add attachment(s) to messages: - Check this option if you wish to add one or
more attachment to email notifications.  Click the "..." button to browse for the
attachment file(s).  The file(s) specified are only attached when the "Add
attachment(s) to messages:" option is enabled.  This option is disabled by default,
and can only be enabled when the "Enable Email notifications" option is enabled.

Audio Notifications:
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1. Enable sound alerts: - Check this option if you wish to have Service Hawk play
sound notifications upon finding a stopped service.  Click the "..." button to browse
for an audio file.  The audio file must be in Wave format (*.wav), and is only played
when the "Enable sound alerts:" option is enabled.  This option is disabled by default.
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4 Privacy Policy

(Note: This document is subject to change without notice.  Please view the Privacy Policy
online for the latest version of this document.)

Your privacy is very important to us. Wingenuity, Inc. will never share, sell, lend or
otherwise make any customer information available to third parties without your consent,
unless it is required by law for us to do so.

We may occasionally contact you regarding product updates, bug fixes, or other product
related information.

Cookies:

Our website makes use of anonymous cookies to track the way our website is used. A
cookie is a small amount of data that is sent from our web server to your browser. This
small amount of data is then stored on your hard drive so that it may be accessed later
for informational purposes. That information can then be used to: track your progress
when placing an order, help ensure affiliate effectiveness, analyze the way our site is
being used, etc. No personally identifiable information is stored in our cookies.

Information Collection and Usage:

We gather general website usage information (such as the number of times our products
have been downloaded, the number of times specific pages have been visited, etc). Also,
when you visit our website or order our products, we may ask that you provide us with
certain types of personal information (such as your name, mailing address and email
address). We use this information, for example, to fulfill and/or ship orders placed from
our website.

External Links:

Our website may contain links to third-party websites. We have no control over any
content, policies or practices employed by these websites. We suggest that you read any
policies applicable to the site you are visiting as, for example, this privacy policy only
applies to our website.

Website Security:

This site has security measures in place to protect the loss, misuse and alteration of the
information under our control.

Changes to this Privacy Policy:

http://www.servicehawk.com/privacy.html?loc=docs
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Wingenuity, Inc. reserves the right to amend this policy from time to time without
advance notice. Any amended terms will be posted clearly on this website.

Acceptance of Terms:

By accessing this website (and using our software products and services) you are
agreeing to the practices regarding the information collection, and its associated use, as
described in this policy.
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